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1. ИНФОРМАЦИЯ О ПРОДУКТЕ 

 

1.1 Описание продукта 

 

COrDIS «ЭКСПЕРТ» – набор реагентов для молекулярно-генетической 

идентификации личности на основе мультиплексного ПЦР-анализа 19-ти 

локусов, содержащих короткие тандемные повторы (STR-локусы) и локуса гена 

амелогенина в геномной ДНК человека. Из 19-ти анализируемых STR-локусов 

13 составляют стандартную панель CODIS (системы комбинированного индекса 

ДНК: D3S1358, D5S818, D7S820, D8S1179, D13S317, D16S539, D18S51, D21S11, 

CSF1PO, FGA, TH01, TPOX, и VWA), 5 локусов рекомендованы ENFSI 

(Европейской Сетью Институтов Криминалистики) для расширения 

европейских национальных баз данных (D1S1656, D2S441, D10S1248, D12S391 

и D22S1045) и локус SE33 - наиболее полиморфный из известных STR-

маркеров. Праймеры для ПЦР подобраны с учетом проведения амплификации 

всех 20-ти локусов в одной пробирке. Размер всех амплифицируемых ПЦР 

продуктов <420 пар нуклеотидов (с учетом всех известных аллелей). Анализ 

результатов ПЦР проводится методом капиллярного электрофореза с 

использованием автоматических генетических анализаторов с 

лазериндуцированной флуоресцентной детекцией. В наборе используется пять 

флуоресцентных красителей, характеризующихся разными длинами волн 

эмиссии для возможности одновременной детекции в разных каналах 

флуоресценции. Праймеры мечены четырьмя флуоресцентными красителями, 

детектируемыми в каналах Blue, Green, Yellow, Red. Стандарт длины S550 мечен 

пятым флуоресцентным красителем и детектируется в отдельном канале Orange 

одновременно с продуктами ПЦР. 

Для получения полного STR-профиля образца достаточно 0.2 

нанограмм недеградированной ДНК. Оптимальное количество – 0.5 нанограмм. 

Общий объем реакции составляет 25 мкл. При работе с препаратами 

ДНК, полученными из образцов сравнения и содержащими заведомо 

достаточное для исследования количество генетического материала (например, 

при работе с препаратами ДНК, полученными из образцов буккального 

эпителия) ПЦР реакция может проводиться в объеме 10 мкл. Не рекомендуется 

снижать объем реакции в случае анализа низкокопийных препаратов ДНК, 

препаратов ДНК содержащих ингибиторы ПЦР, а также препаратов, 

содержащих деградированный генетический материал.  

Максимальный объем вносимого в реакцию раствора ДНК может 

составлять 10 мкл при общем объеме реакции 25 мкл. В случае проведения 

реакции амплификации в объеме 10 мкл максимальный объем вносимого в 

реакцию раствора ДНК может составлять 4 мкл. 

Набор COrDIS «ЭКСПЕРТ» может использоваться для создания 

национальных криминалистических баз данных в странах, использующих в 

качестве стандартной панели локусов маркеры CODIS (Combined DNA Index 

System), а также Европейских баз данных на основе ESS (European standard set), 
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включая страны, использующие SE33 как обязательный маркер. Благодаря 

максимальному дискриминирующему потенциалу среди доступных на данных 

момент коммерческих наборов, COrDIS «ЭКСПЕРТ» прекрасно подходит для 

ДНК-идентификации личности, анализа родства (например, экспертизы 

спорного отцовства), а также для анализа химеризма после пересадки костного 

мозга. 

Набор валидирован для проведения ПЦР в амплификаторах: GeneAmp® 

9700, GeneAmp® 2720, ProFlex PCR System, Veriti™ 96-Well Thermal Cycler, 

SimpliAmp™ Thermal Cycler. Анализ ПЦР-продуктов может проводиться с 

использованием генетических анализаторов ABI PRISM® 

310/3130/3130XL/3500/3500XL (Applied Biosystems) и Нанофор 05 (Синтол). 
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Таблица 1. Описание STR-локусов COrDIS «ЭКСПЕРТ»  

 
Маркер Реф. номер Реф. аллель Хромосомная Структура единицы 

 GenBank® GenBank® локализация повтора реф. аллеля  

 

D1S1656 NC_000001.9 17 1q42 [TAGA]16 [TGA][TAGA][TAGG]1[TG]5 

D2S441 AL079112 12 2p14 [TCTA]12 

D3S1358 NT_005997 18 3p21.31 TCTA [TCTG]2 [TCTA]15 

D5S818 AC008512 11 5q23.2 [AGAT]11 

D7S820 AC004848 13 7q21.11 [GATA]13 

D8S1179 AF216671 13 8q24.13 [TCTA]3 

D10S1248 AL391869 13 10q26.3 [GGAA]13 

D12S391 G08921 19.3 12p13.2 [AGAT]5 GAT[AGAT]7 [AGAC]6 

    AGAT 

D13S317 AL353628 11 13q31.1 [TATC]11 

D16S539 AC024591 11 16q24.1 [GATA]11 

D18S51 AP001534 18 18q21.33 [AGAA]18 

D21S11 AP000433 29 21q21.1 [TCTA]4[TCTG]6 

    [TCTA]3TA[TCTA]3 

    TCA [TCTA]2TCCATA [TCTA]11 

D22S1045 AL022314 17 22q12.3 [ATT]14 ACT [ATT]2 

CSF1PO X14720 12 5q33.1 [AGAT]12 

FGA M64982 21 4q31.3 [TTTC]3 TTTTTTCT[CTTT]13 

    CTCC[TTCC]2 

SE33 V00481 26.2 6q14 [AAAG]8 AA [AAAG]17 

TH01 D00269   9 11p15.5 [TCAT]9 

TPOX M68651 11 2p25.3 [AATG]11 

VWA M25858 18 12p13.31 TCTA [TCTG]4 [TCTA]13 

 

Амелогенин X M55418 X Xp22.1-22.3 

Амелогенин Y M55419 Y Yp11.2 

 

Таблица 1 Сводная информация о STR-локусах набора COrDIS «ЭКСПЕРТ». Структура 

единицы повтора приводится в соответствии с рекомендациями Международного 

Общества Судебных Генетиков (International Society for Forensic Genetics - ISFG) [Bär et 

al, 1997]. Локус амелогенина не является STR-маркером, однако продукты амплификации 

этого локуса для хромосом X и Y различаются по длине. 

 

 

1.2 Компоненты набора и состав 

 
1. Пробирка с реакционной смесью  2 пробирки, 1.0 мл 

2. Раствор активатора 5х    1 пробирка, 1.0 мл  

3. Деионизированная вода   1 пробирка, 1.7 мл 

4. Контрольная ДНК MK01   1 пробирка, 0.1 нг/мкл 

5. Стандарт длины S550     2 пробирки, 120 нанесений 

6. Аллельная лестница    1 пробирка, 50 нанесений 
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Реакционная смесь представляет собой раствор, содержащий компоненты 

полимеразной цепной реакции включая Taq-полимеразу, смесь дНТФ, 

реакционный буфер, праймерную смесь. 

Раствор активатора используется для активации реакционной смеси. 

Содержит буферный раствор и ионы магния Mg2+ в качестве активатора 

полимеразной цепной реакции. 

Деионизированная вода предназначена для доведения реакций до рабочего 

объема. 

Контрольная ДНК МК01 представляет собой высокомолекулярную 

геномную ДНК мужчины в концентрации 0.1 нг/мкл с известным генотипом по 

всем исследуемым локусам. Предназначена для контроля этапов амплификации, 

электрофореза и анализа данных. 

Стандарт длины S550 представляет собой лиофилизированную смесь 

флуоресцентно-меченных фрагментов ДНК разной длины, меченых 

спектральным аналогом LIZ, детектируемым в канале Orange. Стандарт длины 

S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 80, 90, 100, 120, 

140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 

450, 500, 550. Стандарт S550 используется на этапе капиллярного 

электрофореза, вносится в каждый капилляр одновременно с исследуемым 

образцом и служит опорным внутренним стандартом для построения кривой 

подвижности амплифицированных фрагментов исследуемого образца. 

Благодаря высокой плотности фрагментов стандарта S550 обеспечивается 

высокая точность и воспроизводимость определения длины 

амплифицированных фрагментов исследуемого образца. Перед использованием 

требует добавления воды (п. 2.1). 

Аллельный лэддер представляет собой лиофилизированную смесь из 

флуоресцентно-меченных амплифицированных фрагментов ДНК, 

соответствующих всем аллельным вариантам исследуемых локусов, 

встречающимся с частотой более 1%. Аллельная лестница используется на этапе 

капиллярного электрофореза, анализируется параллельно с каждой серией 

образцов для идентификации аллельных вариантов исследуемых локусов. 

Аллельная лестница содержит ПЦР-продукты и при несоблюдении мер 

предосторожности может быть источником контаминации остальных реагентов. 

Поставляется в лиофилизированном виде. Перед использованием требует 

добавления воды (п. 2.2). 

 

1.3 Условия хранения 

 

Компоненты набора необходимо хранить при температуре от -15°C до  

-25°C. После начала использования допускается хранение при 

температуре от +2°C до +8°C в течение 1 месяца. Длительное хранение 

компонентов набора рекомендовано при температуре от -15°C до  

-25°C. 
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В соответствии с действующими Техническими Условиями допускается 

режим транспортировки при температуре не выше +25°C в течении 14 

календарных дней.  

 

 

1.4 Основные характеристики набора 

 

Количество одновременно анализируемых маркеров – 20; 

Список одновременно анализируемых локусов:  
D3S1358, TH01, D12S391, D1S1656, D10S1248, D22S1045, D2S441, D7S820, D13S317, 

FGA, TPOX, D18S51, D16S539, D8S1179, CSF1PO, D5S818, VWA, D21S11, SE33, 

Амелогенин 
Количество флуоресцентных меток, используемых в наборе – 5 

Оптимальное количество вносимой ДНК: 0.5 нг 

Предел чувствительности: 100 пг 

Дискриминирующий потенциал набора: менее 1 из 1021 

Функциональные характеристики набора COrDIS «ЭКСПЕРТ» 

определены на основании результатов валидационных исследований наборов 

реагентов согласно международным рекомендациям SWGDAM.  

 

1.5 Гарантии качества 

 

Качество каждого компонента набора проверено и контролируется в 

процессе производства. Каждый выпущенный лот реагентов регулярно 

проверяется на соответствие заявленным характеристикам в течение 18 месяцев. 

В случае возникновения вопросов относительно качества набора COrDIS 

«ЭКСПЕРТ», просим незамедлительно связаться с ООО “ГОРДИЗ”. 

 

1.6 Сопутствующие материалы 

 

Необходимые материалы, не входящие в набор: 

 

Матриксный стандарт CS5   (ООО “ГОРДИЗ”). 

Бины и панели для GeneMapperTM (ООО “ГОРДИЗ”, предоставляются бесплатно 

по запросу).  

 

Материалы, поставляемые другими производителями: 

 
Реагент    Производитель  Каталожный номер 

Hi-DiTM Formamide  Applied Biosystems (P/N 4311320) 

10 x Genetic Analyzer Buffer Applied Biosystems (P/N 402824) 

Polymer (POP-4)   Applied Biosystems (P/N 402838)  
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2.  РАЗВЕДЕНИЕ СУХИХ КОМПОНЕНТОВ 

 

2.1 Размерный стандарт S550 

 
Сразу после получения набора необходимо извлечь комплект для 

электрофореза и хранить отдельно в зоне для работы с ПЦР продуктами в 

темном месте при температуре +2– +8 °C.  

Перед использованием добавить 120 мкл деионизированной воды в 

пробирку с сухим размерным стандартом S550. Тщательно перемешать на 

вортексе и собрать на дне пробирки коротким центрифугированием. После 

разведения готовый раствор допускается хранить при температуре +2– +8 °C в 

течение месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 

добавить 1 мкл стандарта S550 в каждую лунку планшета, содержащую 

формамид и ПЦР продукт. 

Объем вносимого в лунку размерного стандарта S550 может быть 

снижен до 0.3 мкл для увеличения возможного количества инжекций. При этом 

для оптимизации уровня сигнала рекомендуется использовать 1 мкл стандарта 

S550 для каждого исследуемого препарата. Дополнительный размерный 

стандарт S550 может быть заказан по каталожному номеру S550-10. 

 

2.2  Аллельный лэддер 

 
Сразу после получения набора, пробирку с аллельным лэддером 

необходимо извлечь из коробки и хранить отдельно в зоне для работы с 

ПЦР продуктами в темном месте. Для получения рабочего раствора добавить в 

пробирку с сухим аллельным лэддером 50 мкл деионизированной воды, 

поставляемой с набором. Тщательно перемешать на вортексе и собрать на дне 

пробирки центрифугированием в течение нескольких секунд. После разведения 

готовый раствор допускается хранить при температуре +2– +8 °C в течение 

месяца. Длительное хранение готового раствора рекомендовано при 

температуре от -15°C до -25°C. Для проведения капиллярного электрофореза 

необходимо добавить 1 мкл лэддера в смесь формамида и размерного стандарта. 

При недостаточной чувствительности генетического анализатора допускается 

увеличение объема вносимой в лунку аллельной лестницы до 2 мкл. 
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3. ПЦР АМПЛИФИКАЦИЯ 

 

3.1 Постановка реакции в 25 мкл 

 

В каждую пробирку необходимо внести 10 мкл Реакционной смеси, 

5 мкл Активатора. Затем внести до 10 мкл раствора исследуемой геномной ДНК 

в количестве 0.2–1 нг. Оптимальное количество вносимой ДНК – 0.5 нг. 

Вносимый объем ДНК зависит от ее концентрации. Максимально возможный 

объем вносимого раствора ДНК составляет 10 мкл. При необходимости довести 

общий объем реакции до 25 мкл деионизированной водой, поставляемой в 

составе набора. При внесении в реакцию амплификации 10 мкл исследуемого 

препарата, его оптимальная концентрация должна составлять 0.05 нг/мкл. 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь    10 мкл 

Раствор Активатора 5X     5 мкл 

Геномная ДНК (0.2–1 нг)             до 10 мкл 

Деионизированная вода, до конечного объема 25 мкл  

 

COrDIS «ЭКСПЕРТ» обладает высокой устойчивостью к ингибиторам. 

В связи с этим, как правило, большие объемы раствора ДНК не вызывают 

трудностей. При разведении геномной ДНК водой важно помнить, что в 

деионизированной воде происходит постоянный гидролиз ДНК. Для 

длительного хранения рекомендуется разведение ДНК в буферах (pH> 7), 

содержащих небольшое количество ЭДТА (например, TE с 0.1 mM ЭДТА). 

Высокая концентрация ЭДТА в растворе ДНК может быть причиной снижения 

эффективности реакции вследствие хелатирования ионов магния. 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (5 мкл контрольной ДНК + 5 мкл 

деионизированной воды, поставляемой с набором) и один отрицательный 

контроль (10 мкл деионизированной воды вместо ДНК). 
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3.2 Постановка реакции в 10 мкл 

 

При работе с высококонцентрированными препаратами ДНК, 

содержащими заведомо пригодный для исследования генетический материал 

человека (например, препаратами ДНК, полученными из образцов буккального 

эпителия или иных образцов сравнения), объем реакции может быть сокращен 

до 10 мкл.  

В каждую пробирку необходимо внести 4 мкл Реакционной смеси, 

2 мкл Активатора. Затем внести до 4 мкл раствора исследуемой геномной ДНК в 

количестве 0.2–1 нг. Оптимальное количество вносимой ДНК – 0.4 нг. 

Вносимый объем ДНК зависит от концентрации исследуемого препарата. 

Максимально возможный объем вносимого раствора ДНК составляет 4 мкл. 

При необходимости довести общий объем реакции до 10 мкл деионизированной 

водой, поставляемой в составе набора. При внесении в реакцию амплификации 

4 мкл исследуемого препарата, его оптимальная концентрация должна 

составлять 0.1 нг/мкл. 

 
Компоненты набора Объем на 1 реакцию 

Реакционная смесь     4 мкл 

Раствор Активатора 5X     2 мкл 

Геномная ДНК (0.2–0.1 нг)               до 4 мкл  

Деионизированная вода, до конечного объема 10 мкл 

 

COrDIS «ЭКСПЕРТ» обладает высокой устойчивостью к ингибиторам. 

В связи с этим, как правило, большие объемы раствора ДНК не вызывают 

трудностей. При разведении геномной ДНК водой важно помнить, что в 

деионизированной воде происходит постоянный гидролиз ДНК. Для 

длительного хранения рекомендуется разведение ДНК в буферах (pH> 7), 

содержащих небольшое количество ЭДТА (например, TE с 0.1 mM ЭДТА). 

Высокая концентрация ЭДТА в растворе ДНК может быть причиной снижения 

эффективности реакции вследствие хелатирования ионов магния. 

После внесения всех компонентов, реакционную смесь необходимо 

тщательно перемешать до гомогенного состояния 5–8 кратным пипетированием, 

либо используя вортекс. При необходимости собрать раствор на дне пробирки 

коротким центрифугированием. Тщательное перемешивание необходимо для 

максимальной эффективности реакции. 

С каждой серией исследуемых образцов необходимо амплифицировать 

один положительный контроль (4 мкл контрольной ДНК, поставляемой с 

набором) и один отрицательный контроль (4 мкл деионизированной воды 

вместо ДНК). 
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3.3 Условия амплификации 

 

Приведенные ниже условия амплификации рекомендуются в качестве 

стандартных параметров. Важно соблюдение скорости нагрева 0.3°C/сек. на 

этапе повышения с температуры с 59°C до 72°C. В связи с высокой сложностью 

амплификации с участием более 20 пар праймеров данная скорость нагрева 

критична для оптимальной эффективности реакции.  

  

Параметры ПЦР: 

____________________________ 

94°C 3 мин 

 

98°C 30 сек 

59°C 2 мин   4 цикла 

72°C* 1 мин 30 сек 

 

94°C 30 сек 

59°C 2 мин   6 циклов 

72°C* 1 мин 30 сек 

 

90°C 30 сек 

59°C 2 мин   18 циклов 

72°C* 1 мин 15 сек 

 

68°C 10 мин 

15°C  ∞ 
* Рекомендуемая скорость нагрева с 59°C до 72°C - не более 0.3°C/1 сек. 

 

В случае, если используемая модель амплификатора не позволяет точно 

устанавливать скорость нагрева, рекомендуется воспользоваться секундомером 

для подбора рекомендуемой скорости. 

Например, в моделях амплификаторов GeneAmp 9700 не предусмотрена 

возможность точного программирования скорости изменения температуры, но 

реализовано ограничение скорости нагрева в процентном отношении. В 

приведенном ниже примере показаны подобранные значения скорости нагрева в 

процентном выражении для амплификаторов GeneAmp 9700, в режиме 

эмуляции GeneAmp 9600. Включение режима эмуляции скорости нагрева 

GeneAmp 9600 является обязательным условием для корректной работы 

программы амплификации на приборах GeneAmp 9700. 

 

 

 

 

59.0 

100% 

3 Tmp 4 Cycles 1Hold 

94.0 98.0 72.0 

100% 35% 

3 Tmp 6 Cycles 

94.0 

59.0 

72.0 
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90.0 

59.0 
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100% 

100% 

35% 
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              При работе с низкокопийными препаратами ДНК (<0.1 нг ДНК) можно 

повысить чувствительность реакции добавив 2–4 дополнительных цикла ПЦР в 

последний блок программы. Не рекомендуется превышать суммарно 34 цикла 

амплификации. В этом случае возрастает опасность ошибки вследствие 

выпадения аллелей и дисбаланса гетерозигот. 

После завершения программы амплификации ПЦР продукты можно 

хранить неделю при 4°C – 8°C в защищенном от света месте. В случае, если 

амплифицированные продукты необходимо хранить более недели, 

рекомендуется заморозка при -20°C.  

 

 

4. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ ABI PRISM 3130/3130XL 

 

При работе с генетическим анализатором ABI PRISM, и последующем 

анализе флуоресцентных профилей в программе GeneMapperTM, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации пяти флуоресцентных меток COrDIS 

«ЭКСПЕРТ» необходимо проведение спектральной калибровки для набора 

красителей “Any5Dye” с использованием матрикс-стандарта CS5. 

 

4.1 Создание матрикса / спектральная калибровка 

 

Анализ продуктов амплификации COrDIS «ЭКСПЕРТ» на генетическом 

анализаторе возможен только после проведения калибровки с 5-ти цветным 

матрикс-стандартом CS5 (не поставляется с набором, заказывается отдельно по 

каталожному номеру: CS5). Матрикс-стандарт содержит смесь 5-ти фрагментов 

разной длины, меченных разными флуоресцентными красителями. Эти 

красители использованы в наборе для мечения ПЦР-продуктов и размерного 

стандарта S550. 

Для приготовления рабочего раствора матрикс-стандарта CS5 добавить 

50 мкл деионизированной воды в пробирку, содержащую лиофилизированный 

CS5 и инкубировать при комнатной температуре 2 мин. Затем тщательно 

перемешать раствор на вортексе и собрать на дне пробирки коротким 

центрифугированием. Готовый раствор можно хранить в темном месте при 

температуре +2 °C – +8 °C до 2 недель. Для длительного хранения 

рекомендуется заморозка при -15°C – -25°C. 

При проведении спектральной калибровки настоятельно 

рекомендуется использовать только чистые септы, новый буферный раствор и 

воду. Использование при проведении спектральной калибровки ранее 

использованных септ, может приводить к попаданию в область анализа ранее 

исследованных меченных ПЦР продуктов, и препятствовать успешному анализу 

матричного стандарта. 
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Подготовка матрикс-стандарта для калибровки (ABI 3130 /4 капилляра) 

 

Hi-DiTM формамид 40 мкл 

Раствор CS5    4 мкл 

 

Добавить по 10 мкл смеси в лунки A01-D01 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Подготовка матрикс-стандарта для калибровки (ABI 3130XL/16 

капилляров) 

 

Hi-DiTM формамид 160 мкл 

Раствор CS5    16 мкл 

 

Добавить по 10 мкл смеси в лунки A01- H02 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 

Шаг А – Создание Instrument Protocol для спектральной калибровки 

 

Открыть Protocol Manager в программе Data Collection Software 

Зайти во вкладку Instrument Protocol и выбрать New чтобы открыть Protocol 

Editor 

Ввести следующие параметры в окне Protocol Editor (Instrument Protocol): 

 

Параметр  Значение 

Name   например, Spectral36_POP4_СS5 

Type   SPECTRAL 

Dye Set   Any5Dye 

Polymer   POP4  

Array Length  36 

Chemistry  Matrix Standard 

Run Module  Spect36_POP4_1 

 

Выбрать OK и закрыть Protocol Editor 

 

Шаг Б – Создание планшета 

 

Перейти в Plate Manager программы Data Collection Software выбрать кнопку 

New. Откроется окно Plate Dialog. 

 

Ввести следующие параметры в диалоговом окне New Plate: 

Name    например, Spectral_any5_CS5 



COrDIS  Инструкция пользователя                                     231016 

 

- 14 - 

 

Application   Spectral Calibration 

Plate Type   96-Well 

 

Выбрать OK. Появится новая таблица Plate Editor 

 

Ввести в позиции A01: 

Sample Name  например, CS5 

Priority   например, 100 

Instrument Protocol Spectral36_POP4_ CS5  

 

Выделить ячейку A01 целиком. В меню Edit выбрать команду Fill Down Special. 

Программа заполнит введенными значениями соответствующее количество 

ячеек для одной загрузки капилляров. Например, от A01 до A04 (ABI 3130 / 4 

капилляра) или от A01 до H02 (ABI 3130XL / 16 капилляров). 

Выбрать OK чтобы закончить создание планшета и выйти из Plate Editor. 

 

Шаг C – Проведение спектральной калибровки 

 

Перейти во вкладку Run Scheduler – Plate View и выбрать Find All. 

Выбрать заданное название созданного планшета (например, Spectral_any5_ 

CS5). Связать выбранное название с установленным в прибор планшетом. 

Запустить прибор. 

 

Шаг D – Оценка результатов спектральной калибровки 

 

После завершения работы прибора проверить статус каждого капилляра 

(pass или fail). Открыть Instrument Status, перейти во вкладку Event Log. В 

окне Event Messages отображается статус всех капилляров. Каждый капилляр 

должен иметь значение Q-value не ниже 0.95. Высота пиков должна быть не 

менее 1.000 rfu, но не более 5.000 rfu (оптимальный диапазон между 2000 и 4000 

rfu). 

Дополнительно в окне Spectral Viewer можно просмотреть 

флуоресцентный профиль калибровки для каждого капилляра. Калибровка 

должна быть успешной минимум для 3 из 4 капилляров (или для 12 из 16 

капилляров, соответственно). При использовании CS5 в качестве матриксного 

стандарта, в окне профиля калибровки должна отражаться следующая 

последовательность пиков синий-зеленый-желтый-красный-оранжевый. 

В случае успешной калибровки рекомендуется ее переименовать, 

присвоив более удобное название. Для этого нажать кнопку Rename, ввести 

новое название калибровки (например, CS5_[дата]) и нажать OK. Нужно иметь 

в виду, что для каждого набора виртуальных фильтров (dye set) последняя 

калибровка автоматически становится активной. Если планируется использовать 

результаты предыдущих калибровок, их необходимо активировать до запуска 

прибора. 
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4.2 Условия капиллярного электрофореза 

 

Перед проведением первого анализа продуктов амплификации COrDIS 

«ЭКСПЕРТ» на генетическом анализаторе, необходимо создать 

соответствующий модуль Run Module. Для этого перейти в Module Manager 

программы Data Collection Software и нажать кнопку New. Откроется окно Run 

Module Editor. Создать модуль со следующими параметрами: 

 

Параметр  Значение 

Oven Temperature      60 

Poly Fill Volume  4840 

Current Stability         5 

PreRun Voltage      15 

PreRun Time    180 

Injection Voltage     1.2 

Injection Time      10 

Voltage Number of Steps     40 

Voltage Step Interval     15 

Data Delay Time        1 

Run Voltage   13.0 

Run Time  1700 

 

В зависимости от состояния используемого прибора, параметр Injection Time 

может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала. Параметр Run Time также может быть 

скорректирован пользователем в случае, если рекомендуемое время фореза 

является избыточным (все фрагменты размерного стандарта детектируются 

существенно раньше отведенного времени) или недостаточным (не все 

фрагменты размерного стандарта детектируются за отведенное время). 

Оптимальное время фореза в наибольшей степени зависит от текущего 

состояния капилляров и полимера в генетическом анализаторе и может меняться 

со временем. 

 

Нажать Save As и ввести удобное название для созданного модуля (например, 

COrDIS). Нажать OK и покинуть редактор модуля, нажав Close. 

 

4.3 Создание Instrument Protocol 

 

Перейти в раздел Protocol Manager программы Data Collection Software. В 

окне Instrument Protocol нажать кнопку New, чтобы открыть редактор 

протокола Protocol Editor. 

 

Необходимо ввести следующие параметры: 
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Параметр Значение 

Name  Run36_COrDIS 

Type  REGULAR 

Run Module COrDIS 

Dye Set  Any5Dye 

 

Нажать кнопку OK чтобы сохранить изменения и выйти из редактора 

протокола. 

 

4.4 Подготовка и загрузка продуктов амплификации 

 

Для загрузки образцов в прибор необходимо приготовить смесь Hi-DiTM 

формамида и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 

Hi-DiTM формамид  10.0 мкл 

Размерный стандарт S550      1 мкл 

 

При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна 

лунка при анализе каждой серии образцов должна содержать аллельную 

лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 

планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной 

лестницы. При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 

Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

 

__________ 

95°C 2 мин 

4°C _ 1 мин 

 
 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя ABI PRISM® Genetic Analyzer. 

 

При проведении реакции амплификации в объеме 10 мкл (при 

исследовании образцов сравнения) один набор реагентов COrDIS «ЭКСПЕРТ» 

позволяет провести исследование 500 образцов. В состав набора входит 
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аллельная лестница, рассчитанная на проведение 20 инжекций (при нанесении 1 

мкл аллельной лестницы в лунку планшета). При необходимости количество 

инжекций аллельной лестницы может быть увеличено путем снижения объема 

вносимой в лунку аллельной лестницы до 0.5 мкл (без потери качества анализа). 

Объем вносимого в лунку размерного стандарта S550 также может быть снижен 

до 0.5 мкл для увеличения возможного количества инжекций. При этом для 

оптимизации уровня сигнала рекомендуется использовать 1 мкл стандарта S550 

для каждого исследуемого препарата. Дополнительный размерный стандарт 

S550 может быть заказан по каталожному номеру S550-10. 

 

4.5 Запуск прибора 

 

Проведение капиллярного электрофореза на генетическом анализаторе 

ABI PRISM® проводится в соответствии с инструкцией пользователя, 

предоставляемой производителем. Для получения корректных результатов 

необходимо создать соответствующую спектральную калибровку, Run Module, и 

Instrument Protocol. 

 

Шаг A – Создание планшета 

 

Перед началом анализа необходимо создать Plate (планшет), 

описывающий расположение образцов на планшете и содержащий инструкции 

для прибора. Перейти в Plate Manager программы Data Collection Software и 

нажать кнопку New. Появится диалоговое окно Plate Dialog. Ввести следующие 

параметры: 

 

Параметр      Значение  

Name    Например COrDIS_[дата] 

Application   выбрать GeneMapper 

Plate Type   96-Well 

 

Нажать кнопку OK. Появится новая таблица Plate Editor. 

 

Шаг B – Заполнение таблицы 

 

Параметр   Значение  

Sample Name  Название образца 

Priority   обычно 100 (очередность анализа по возрастанию) 

Sample Type  Sample / Allelic Ladder / Positive Control / Neg. Control 

Size Standard  S550 

Panel   COrDIS 

Analysis Method  Например, GORDIZ 

User-defined 1-3 

SNP Set 
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Results Group  Выбрать соответствующий Results Group 

Instrument Protocol Run36_COrDIS 

 

Для удобства в первую очередь лучше ввести все названия образцов. 

Затем, для первого образца задать все необходимые параметры. Выделить 

курсором мыши все столбцы. В меню Edit выбрать пункт Fill Down. Программа 

заполнит значениями все выделенные ячейки. После этих действий 

редактировать столбец Sample Type, выбрав между значениями Allelic Ladder / 

Positive Control / Negative Control. 

 

Шаг C – Запуск прибора и информация о статусе прибора 

 

Перейти в раздел Run Schedule и нажать на кнопку Find All. Найти в 

списке название созданного планшета, выделить его и связать нажатием мыши с 

изображением установленного в приборе планшета. Запустить анализ планшета. 

Флуоресцентные профили образцов можно наблюдать в реальном 

времени в разделе Capillaries Viewer или Cap/Array Viewer. В случае 

возникновения системных ошибок информация о них появится в разделе Event 

Log (Error Status). 

 

4.6 Оптимизация интенсивности сигналов 

 

Для повышения интенсивности сигнала возможно увеличение времени 

инжекции. Усиление сигнала также возможно с помощью очистки ПЦР-

продукта от праймеров и солей. Количество размерного стандарта в этом случае 

следует так же уменьшить.  

 

5. ЭЛЕКТРОФОРЕЗ НА АНАЛИЗАТОРЕ ABI PRISM 3500/3500XL 

 

При работе с генетическим анализатором ABI PRISM и последующем 

анализе флуоресцентных профилей в программе GeneMapperTM, необходимо 

следовать инструкциям пользователя от производителя оборудования. 

Для корректной визуализации пяти флуоресцентных меток COrDIS 

«ЭКСПЕРТ» необходимо проведение спектральной калибровки для набора 

красителей “CS5”. 

 

5.1 Создание матрикса / спектральная калибровка 

 

Анализ продуктов амплификации COrDIS «ЭКСПЕРТ» на генетическом 

анализаторе возможен только после проведения калибровки с 5-ти цветным 

матрикс-стандартом CS5 (не поставляется с набором, заказывается отдельно по 

каталожному номеру: CS5). Матрикс-стандарт содержит смесь 5-ти фрагментов 

разной длины, меченных разными флуоресцентными красителями. Эти 
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красители использованы в наборе для мечения ПЦР-продуктов и размерного 

стандарта S550. 

Для приготовления рабочего раствора матрикс-стандарта CS5 добавить 

50 мкл деионизированной воды в пробирку, содержащую лиофилизированный 

CS5 и инкубировать при комнатной температуре 2 мин. Затем тщательно 

перемешать раствор на вортексе и собрать на дне пробирки коротким 

центрифугированием. Готовый раствор можно хранить в темном месте при 

температуре +2 °C – +8 °C до 2 недель. Для длительного хранения 

рекомендуется заморозка при -15°C – -25°C. 

При проведении спектральной калибровки настоятельно 

рекомендуется использовать только чистые септы, новый буферный раствор и 

воду. Использование ранее использованных септ при проведении спектральной 

калибровки может приводить к попаданию ранее исследованных меченных ПЦР 

продуктов в область анализа, и препятствовать успешному анализу матричного 

стандарта. 

 

Подготовка матрикс-стандарта для калибровки (ABI 3500 /8 капилляров) 

 

Hi-DiTM формамид  80 мкл 

Раствор CS5     8 мкл 

 

Добавить по 10 мкл смеси в лунки A01-H01 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Подготовка матрикс-стандарта для калибровки (ABI 3500XL/ 24 

капилляра) 

 

Hi-DiTM формамид  240 мкл 

Раствор CS5     24 мкл 

 

Добавить по 10 мкл смеси в лунки A01- H03 96-луночного планшета. 

При необходимости удалить пузыри со дна лунок центрифугированием. 

 

Спектральная калибровка 

 

Шаг А – Создание Dye Set для спектральной калибровки 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку Dye Sets. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Dye Set). В 

появившемся окне указать параметры нового Dye Set: 

 

Dye Set Name   CS5 

Chemistry   Matrix standard 
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Dye Set Template G5 Template 

Arrange Dyes  оставить без изменений 

Parameters: 

Matrix condition number  20 

Upper limit 

Minimal Quality Score  0.8 

 

 

 

  

Нажать кнопку Save. Новый Dye Set (CS5) появится в списке. 

 

 

Шаг B – Проведение спектральной калибровки 

 

Перейти в раздел Maintenance в программе Data Collection Software. В 

разделе Calibrate, выбрать вкладку Spectral Calibration. В открывшемся окне 

выбрать количество лунок в используемом планшете (Number of Wells) и 

позицию планшета в приборе (Plate Position). В пункте Chemistry Standard 

выбрать Matrix standard. В пункте Dye Set выбрать CS5. Запустить процесс 

калибровки нажав кнопку Start Run. 
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При проведении спектральной калибровки настоятельно 

рекомендуется использовать только чистые септы, новый буферный раствор и 

воду. 

 

Шаг С – Оценка результатов спектральной калибровки 

 

После завершения работы прибора проверить статус каждого капилляра 

(pass или fail). Высота пиков должна быть не менее 2.000 rfu, но ниже 15.000 rfu 

(оптимальный диапазон между 5000 и 10000 rfu). 

Калибровка должна быть успешной минимум для 6 из 8 капилляров 

(или для 18 из 24 капилляров, соответственно). При использовании CS5 в 

качестве матриксного стандарта, в окне профиля калибровки (Intensity vs Pixel 

Number) должна отражаться следующая последовательность пиков синий-

зеленый-желтый-красный-оранжевый. 

 

 
 

В случае успешной калибровки сохранить полученные результаты, нажав 

кнопку Accept. 

 

5.2 Создание Instrument Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку Instrument Protocols. В открывшемся меню 

нажать кнопку Create (откроется диалоговое окно создания нового Instrument 

Protocol). В появившемся окне указать параметры нового Instrument Protocol: 

 

Application Type   HID 

Dye Set     CS5 

Run Module  например “HID36_POP4” (выбрать протокол 

соответствующий параметрам системы) 

Protocol Name   COrDIS EXPERT 
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Рекомендуемые параметры электрофореза для генетического анализатора ABI 

3500: 

 

Параметр  Значение 

Oven Temperature      60 

PreRun Voltage      15 

PreRun Time    180 

Injection Voltage     1.2 

Injection Time      10 

Data Delay Time        1 

Run Voltage   13.0 

Run Time  1700 

 

Нажать кнопку Save. 

 

В зависимости от состояния используемого прибора, параметр Injection Time 

может быть скорректирован пользователем для достижения оптимальной 

амплитуды флуоресцентного сигнала. Параметр Run Time также может быть 

скорректирован пользователем в случае, если рекомендуемое время фореза 

является избыточным (все фрагменты размерного стандарта детектируются 

существенно раньше отведенного времени) или недостаточным (не все 
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фрагменты размерного стандарта детектируются за отведенное время). 

Оптимальное время фореза в наибольшей степени зависит от текущего 

состояния капилляров и полимера в генетическом анализаторе и может меняться 

со временем. 

 

5.3 Создание Size Standard 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку Size Standards. В открывшемся меню 

нажать кнопку Create (откроется диалоговое окно создания нового Size 

Standard). В появившемся окне указать параметры нового Size Standard. 

Стандарт длины S550 содержит 26 фрагментов ДНК разной длины (н.п.): 60, 70, 

80, 90, 100, 120, 140, 160, 180, 200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 

380, 400, 420, 440, 450, 500, 550. 

 

 

 
 

 

Нажать кнопку Save. 
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5.4 Создание QC Protocol 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Analyze, выбрать вкладку QC Protocols. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового QC Protocol). В 

появившемся окне указать параметры нового QC Protocol: 

 

 

 
 

Нажать кнопку Save. 
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5.5 Создание Assay 

 

Перейти в раздел Library в программе Data Collection Software. 

В разделе Manage, выбрать вкладку Assays. В открывшемся меню нажать 

кнопку Create (откроется диалоговое окно создания нового Assay). В 

появившемся окне указать параметры нового Assay: 

 

Assay Name    COrDIS EXPERT 

Application Type  HID 

Instrument Protocol  COrDIS EXPERT 

 

Нажать кнопку Save. 

 

 

 
 

5.6 Подготовка и загрузка продуктов амплификации 

 

Для загрузки образцов в прибор необходимо приготовить смесь Hi-DiTM 

формамида и размерного стандарта S550 в следующем соотношении: 

 

Компонент    Объем на один образец 

Hi-DiTM формамид  10.0 мкл 

Размерный стандарт S550 1 мкл 
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При расчете объемов компонентов смеси следует учесть, что 

формамидом должны быть заполнены все лунки, в которых будет происходить 

инжекция, в том числе и лунки, не содержащие образцы. Как минимум одна 

лунка при анализе каждой серии образцов должна содержать аллельную 

лестницу. 

После перемешивания добавить по 10 мкл смеси в каждую лунку 

планшета. Затем внести в лунки по 1 мкл ПЦР-продукта или аллельной 

лестницы. При необходимости удалить пузыри со дна лунок планшета коротким 

центрифугированием.  

 

Накрыть планшет резиновым ковриком и провести температурную 

денатурацию по схеме: 

 

__________ 

95°C 2 мин 

4°C _ 1 мин 

 
 

Загрузить планшет с денатурированными образцами в прибор в 

соответствии с инструкцией пользователя ABI PRISM® Genetic Analyzer. 

 

При проведении реакции амплификации в объеме 10 мкл (при 

исследовании образцов сравнения) один набор реагентов COrDIS «ЭКСПЕРТ» 

позволяет провести исследование 500 образцов. В состав набора входит 

аллельная лестница, рассчитанная на проведение 20 инжекций (при нанесении 1 

мкл аллельной лестницы в лунку планшета). При необходимости количество 

инжекций аллельной лестницы может быть увеличено путем снижения объема 

вносимой в лунку аллельной лестницы до 0.5 мкл. Объем вносимого в лунку 

размерного стандарта S550 также может быть снижен до 0.3 мкл для увеличения 

возможного количества инжекций. При этом для оптимизации уровня сигнала 

рекомендуется использовать 1 мкл стандарта S550 для каждого исследуемого 

препарата. Дополнительный размерный стандарт S550 может быть заказан по 

каталожному номеру S550-10. 

 

5.7 Запуск прибора 

 

Проведение капиллярного электрофореза на генетическом анализаторе 

ABI PRISM® проводится в соответствии с инструкцией пользователя, 

предоставляемой производителем. Для получения корректных результатов 

необходимо создать соответствующую спектральную калибровку, Instrument 

Protocol и Assay. 
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Шаг A – Создание планшета 

 

Перед началом анализа необходимо создать Plate (планшет), 

описывающий расположение образцов на планшете и содержащий инструкции 

для прибора. Для этого необходимо перейти в меню Create New Plate 

программы Data Collection Software. Появится диалоговое окно, в котором 

необходимо указать параметры нового планшета: 

 

Name    Например CORDIS_[дата] 

Plate Type   Fragment 

 

Нажать кнопку OK. Появится новая таблица со схемой исследуемого планшета. 

 

Шаг B – Заполнение таблицы 

 

Для всех анализируемых лунок планшета необходимо указать: 

Sample name   имя объекта 

Sample type   тип образца 

Assay     CORDIS EXPERT 

Filename convention  структура имени файла 

Results group   параметры сохранения файлов 

 

Шаг C – Запуск прибора и информация о статусе прибора 

 

После создания схемы расположения образцов на планшете, нажмите на 

кнопку Link Plate for Run. В открывшемся окне указать положение планшета в 

приборе и запустить электрофорез нажатием кнопки Start Run. 

 

 

5.8 Оптимизация интенсивности сигнала 

 

Для повышения интенсивности сигнала возможно увеличение времени 

инжекции. Усиление сигнала также возможно с помощью очистки ПЦР-

продукта от праймеров и солей. Количество размерного стандарта в этом случае 

следует так же уменьшить.  

При работе с высокочувствительными генетическими анализаторами 

ABI3500 могут наблюдаться нежелательные эффекты, связанные с избыточным 

уровнем сигнала флуоресценции амплифицированных продуктов на этапе 

анализа результатов электрофореза. В этом случае рекомендуется снизить 

количество вносимого в реакцию генетического материала до рекомендованных 

0,5 нг геномной ДНК. Дополнительно, снижение избыточного уровня сигнала 

флуоресценции амплифицированных продуктов может быть достигнуто 

снижением времени инжекции образцов до 5–7 сек. 
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6.  АНАЛИЗ ДАННЫХ 

 

6.1 Настройка программного обеспечения GeneMapper 

 

Полученные данные могут быть проанализированы с использованием 

программного обеспечения GeneMapper ID и GeneMapper ID-X. 

Программное обеспечение GeneMapper требует предварительной 

настройки параметров анализа. Параметры анализа для наборов COrDIS могут 

быть импортированы в программу из файлов настроек, предоставляемых 

производителем по запросу. 

Для анализа результатов электрофореза с использованием 

программного обеспечения GeneMapper необходимо произвести следующие 

действия: 

1) Произвести импорт файлов панелей и бинов. 

Выбрать пункт меню Tools-> Panel Manager. 

 

 
 

В левом верхнем сегменте открывшегося окна установить курсор на позицию 

Panel Manager. 
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Затем в меню выбрать File-> Import panels. 

 

 
 

В открывшемся окне найти и выбрать файл с панелями (Например, файл 

EXPERT_Panels). Загрузить нажатием кнопки Import. В левом верхнем сегменте 

окна выбрать загруженную панель (Например, EXPERT), затем в меню выбрать 

File-> Import bin set. В открывшемся окне найти и выбрать файл с бинами 

(Например, файл EXPERT_bins). Загрузить нажатием кнопки Import. Нажать 

кнопки Apply и OK. 

2) Произвести импорт настроек размерного стандарта.  

Выбрать пункт меню Tools> GeneMapper Manager. В открывшемся окне выбрать 

вкладку Size Standards 

 



COrDIS  Инструкция пользователя                                     231016 

 

- 30 - 

 

 
 

Загрузить файл настроек размерного стандарта нажатием кнопки Import. Нажать 

кнопку Done. 

3) Создать новый метод анализа.  

Выбрать пункт меню Tools -> GeneMapper Manager. В открывшемся окне 

выбрать вкладку Analysis Methods.  

 

 
 

Создать новый метод анализа нажатием кнопки New.  

Присвоить имя новому методу анализа. Например, CORDIS EXPERT. 
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Во вкладке Allele выбрать соответствующий набор бинов. 
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Провести настройку параметров анализа во вкладке Peak Detector: установить 

значение параметра Peak Window Size равным 9, отключить нормализацию 

сигнала (Use Normalisation, if applicable). 

 

 
 
Сохранить изменения. 

 

 

 

6.2 Cтандарт длины S550 

 

Ниже приводится пример электрофореграммы с сигналами фрагментов 

стандарта S550 в канале детекции Orange. Обозначения 26 фрагментов ДНК 

приводятся в соответствии с их размером: 60, 70, 80, 90, 100, 120, 140, 160, 180, 

200, 220, 230, 240, 260, 280, 300, 320, 340, 360, 380, 400, 420, 440, 450, 500, 550.  
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Рисунок 1. Электрофореграмма размерного стандарта S550. Размеры фрагментов.  

 
 

 

 

6.3 Диапазоны размеров аллелей STR маркеров 

 
Локус  Диапазон Диапазон длин Аллели  Цвет  

  аллелей  фрагментов MK-1  метки 
 

Amelogenin X       X            81  X  синий 

Amelogenin Y       Y            84  Y  синий 

D3S1358    8 – 21    93 - 147  15/17  синий 

TH01    3 - 14  152 - 196  6/9.3  синий 

D12S391  13 - 28  204 - 264  21/23  синий 

D1S1656    9 - 21  275 - 324  14/17.3  синий 

D10S1248   8 - 21  338 - 390  15/15  синий 

D22S1045   8 - 19  400 - 450  15/15  синий 

D2S441    8 - 19    84 - 134  14/14  зеленый 

D7S820    5 - 16  137 - 181  10/12  зеленый 

D13S317    5 - 17  188 - 236  11/11  зеленый 

FGA  12.2 – 51.2 238 - 391  20/22.2  зеленый 

TPOX    4 - 16    66 - 113  8/9  желтый 

D18S51    7 - 27  124 - 200  14/16  желтый 

D16S539    4 - 16  208 - 356  12/13  желтый 

D8S1179    7 - 20  262 - 214  10/10  желтый 

CSF1PO    5 - 16  317 - 361  9/11  желтый 

D5S818    6 - 18  369 - 413  9/12  желтый 

VWA  10 - 25    94 - 155  16/18  красный 

D21S11  24 – 41.2  158 - 228  30.2/30.2  красный 

SE33  4.2 – 50.2 233 - 403  24.2/29.2  красный 

Таблица 2 Диапазон длин аллелей. 
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6.4 Амплификация контрольной ДНК 

 

 

Рисунок 2 Контрольная ДНК MK01  
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6.5 Аллельная лестница 

 

 

Рисунок 3. Аллельная лестница COrDIS «ЭКСПЕРТ».  
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Юридический и почтовый адрес: 143026 г. г. Москва, территория 

инновационного центра Сколково, ул. Большой Бульвар, д.42, стр. 1, пом.337 

Телефон/факс: +7 (499) 670-40-41, 

Домашняя страница: www.gordiz.ru 
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